Contents

1. Copyright Notice .................................................................................................................................................. 3

2. What is Equinox and Expanded Gamut Printing? ............................................................................................... 5
   2.1 Expanded Gamut Printing and its Benefits ........................................................................................................ 5
   2.2 What is the Equinox Profile Creator? .............................................................................................................. 6

3. Before You Start ..................................................................................................................................................... 7
   3.1 Making Sure your Press is Stable .................................................................................................................... 7
   3.2 Choosing your Inks .......................................................................................................................................... 8
      3.2.1 Inks Choice Guidelines ........................................................................................................................... 9
   3.3 Choosing your Printing Target ....................................................................................................................... 13
      3.3.1 Printing to G7 ........................................................................................................................................ 14
      3.3.2 Printing to ISO, another Standard or a Custom Target ......................................................................... 14

4. Preparing for Measuring in the Equinox Profile Creator ...................................................................................... 15
   4.1 Preferences for Both License-Free and Licensed Mode ................................................................................. 15
   4.2 Preferences Specific to the Licensed Mode .................................................................................................. 17

5. Using the Equinox Profile Creator in Licensed Mode .......................................................................................... 19
   5.1 Creating an Equinox Profile for your Press .................................................................................................... 20
      5.1.1 Defining your Ink Set .............................................................................................................................. 22
      5.1.2 Setting your Desired Curves .................................................................................................................... 23
      5.1.3 Printing and Measuring your Charts ...................................................................................................... 23
      5.1.4 Processing your Profile Sections ........................................................................................................... 31
      5.1.5 Updating your RIP Curves with your Profile Data .............................................................................. 42
   5.2 Exchanging Profiles Between Sites .............................................................................................................. 43
      5.2.1 Importing a Profile ................................................................................................................................ 43
      5.2.2 Exporting a Profile .................................................................................................................................. 44

6. Using the Equinox Profile Creator in License-free Mode .................................................................................... 46
   6.1 Creating a Custom Chart ............................................................................................................................... 47
   6.2 Exchanging Charts Between Sites ................................................................................................................ 48
      6.2.1 Exporting a Chart ................................................................................................................................... 49
      6.2.2 Importing a Chart ................................................................................................................................... 49
   6.3 Measuring your Printed Charts ..................................................................................................................... 50

7. Using your Equinox Profile .................................................................................................................................. 54
   7.1 Creating a Color Strategy for Use in Other Esko Applications ......................................................................... 54
   7.2 Monitoring your Press Output ......................................................................................................................... 54
1. Copyright Notice

© Copyright 2015 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Esko Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of any kind. There are no warranties granted or extended by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or the information contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE®, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2015. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights reserved.
The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm. Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems in the U.S. and other countries. Part of this software uses technology by BestTM Color Technology (EFI). EFI and Bestcolor are registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office. Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007. All other product names are trademarks or registered trademarks of their respective owners. Correspondence regarding this publication should be forwarded to:

Esko Software BVBA
Kortrijksesteenweg 1095
B – 9051 Gent
info.eur@esko.com
2. What is Equinox and Expanded Gamut Printing?

Equinox is Esko’s unique color technology for expanded gamut printing (printing with a standardized set of more than 4 inks).

It combines Esko’s unique color algorithms and workflow expertise to bring unparalleled control of multi-color process to the printing industry.

It is compatible with any 5, 6, or 7 inks of your choice.

2.1 Expanded Gamut Printing and its Benefits

"Four color process" (CMYK) is capable of producing the limited range of colors represented by the triangle below.

Spot colors have traditionally been used to achieve colors outside the CMYK gamut. However, printing with spot colors is not economical. It requires blending custom inks, cleaning and prepping the press decks for each job, and makes it impossible to “gang” items with unique colors on the same form.

Adding extra colors “between” Cyan, Magenta and Yellow (an Orange or Red ink, a Green ink, and a Blue or Violet ink, as on the color hexagon below) expands the gamut and reduces the need for custom spot colors.
Additionally, images are more colorful and closer to the original. The press can use the same 7 inks for every job, resulting in important cost savings in the press room.

2.2 What is the Equinox Profile Creator?

With the Equinox Profile Creator application, you can create an Equinox profile for your conventional press, using 5, 6 or 7 inks of your choice.

To do this, you can either use standard profiling charts, or create your own custom charts (for example you can create narrow charts to profile a narrow web press).

Overcoming the Challenges of Press Profiling

When profiling a press, you may encounter the following typical problems:

- measurement errors due to bad print quality,
- measurement variations across a sheet,
- measurement variations between press runs (for instance when printing different profile sections in different runs for expanded gamut printing),
- difficulty to hit the target/match your desired quality standard.

With the Equinox Profile Creator, you can address these problems by:

- Inspecting the measurement data and repairing faulty patches. See Inspecting and Repairing your Measurement Data on page 32.
- Averaging several measurements of a chart to correct for variations across a sheet or across press runs. See Averaging your Measurement Data on page 34.
- Smoothing your measurements to further compensate for press variation. See Smoothing your Measurement Data on page 37.
- Deriving compensation curves from your measurement data to help you meet your desired target on your production runs. See Synchronizing your Measurement Data to your Desired Curves on page 40.

Licensed and License-free Modes

The Equinox Profile Creator is available in both licensed and license-free mode.

- In licensed mode, all of the Equinox Profile Creator functionality is available.
- In license-free mode, you can only create custom overprint charts and measure charts.

Tip:

If you have several sites, you can for example have a fully licensed Equinox Profile Creator at the main site, and a license-free Equinox Profile Creator at your auxiliary sites.

When a press at an auxiliary site needs profiling, you can print and measure the profiling charts using the license-free Equinox Profile Creator, then export the measurement files and send them to your main site.

Your color expert at the main site can then create an Equinox profile in the fully licensed Equinox Profile Creator for that press.
3. Before You Start

Before you start profiling your press for Equinox expanded gamut printing, there are some preparatory steps you need to take:

1. Making sure your press is stable.
2. Choosing the inks you will use for printing with Equinox.
3. Defining the calibration curves and tolerances you want to use as your quality target.

You can try and match your press output to either:

- a widely accepted standard (for example, you might want to achieve the dot gain specified by the GRACoL G7 specification),
- your custom desired dot gain and Delta E tolerances.

3.1 Making Sure your Press is Stable

This is very important as press variation can have even more of an impact on your printed results than variation in the press profile.

**Dot Gain**

You should make sure your dot gain is stable and under control. Make sure you have some good initial dot gain curves (adapted to your press) set in the RIP when printing your profiling charts.

We recommend you use a PressSync curve set for this (see the PressSync documentation for more information), so that once you have made the profile, you can update that curve set with the profile data.

**Gray Balance**

If you are printing towards G7, make sure your gray balance is good, and adapt your dot gain curves if needed to correct any color cast.
Tip: You can use a P2P test chart to measure both dot gain and gray balance. You can also make a custom P2P chart with the expanded gamut inks you want to use (see Choosing your Inks on page 8).

3.2 Choosing your Inks

With Equinox, you mix your inks on press rather than in the ink room.

You can use Equinox with 5, 6 or 7 inks, but choosing 7 inks will maximize the gamut expansion for your images.

In the picture below, you can see the original CMYK gamut on the left, and the gamut expansion provided by the 3 added colors on the right.

With Equinox, you don’t have to use predetermined inks, you can choose the inks that work best for your jobs.
Below are a few guidelines to help you in your decision: they indicate what we found to give the best results in the majority of cases. However, we recommend you test inks on your press, to make the best choice for your individual requirements.

3.2.1 Inks Choice Guidelines

We recommend you choose single-pigment inks if possible, to get purer colors. You can for example choose inks from your ink supplier's base colors (as in the example below). Consult your ink supplier for advice.

We also recommend you consider the following factors in your decision:

- The level of gamut expansion you want.
- The type of images you usually print.
- The cost of certain inks.
- The printability of certain inks.
- The compatibility of certain inks with your proofing system.

Choosing your CMYK Inks

You can choose any Cyan, Magenta, Yellow and Black inks, but we recommend you keep using the ones you already use, as you have “tried and tested” them for your press.

Choosing your Orange/Red Ink

You can choose either a red or an orange ink.

Choosing a Red Ink
You may want to choose a red ink if you generally print jobs that need more red than orange (for example for fashion work).

Choosing an Orange Ink

You may want to choose an orange ink for two reasons:

- To get maximum gamut expansion: as you can see below, adding a red ink (on the left) provides less gamut expansion than adding an orange ink (on the right).

- If you print jobs that have bright orange hues: you can reproduce a bright red quite accurately by mixing orange and magenta inks, but you can’t reproduce a bright orange with the same accuracy from a red and a yellow ink.
Choosing your Green Ink

You can choose either a bright green ink (green ink mixed with yellow ink) or a single-pigment green ink (Phthalo Green).

**Choosing a Bright Green Ink**

You may want to choose a bright green ink (for example Pantone 354 C) to match a similar ink in your proofing system (for example Kodak Approval).

**Choosing a Single-Pigment Green Ink**

You may want to choose single-pigment green ink (for example Pantone Green C) for two reasons:
- To get maximum gamut expansion: as you can see below, adding a bright green ink (on the left) provides less gamut expansion than adding a single-pigment green ink (on the right).
• If you print jobs that have green hues close to the single-pigment green color: you can reproduce a bright green quite accurately by mixing green and yellow inks, but you can’t reproduce a Phthalo Green with the same accuracy from a bright green and a cyan ink.

\[
\text{Single Pigment Green} + \text{Yellow} = \text{Bright Green}
\]

\[
\text{Bright Green} + \text{Cyan} = \text{Result}
\]

Choosing your Blue/Violet Ink

You can choose either a blue or a violet ink.

Choosing a Blue Ink

You may want to choose a blue ink (for example Pantone Reflex Blue) for three reasons:

• To match a similar ink in your proofing system (for example Kodak Approval).
• If blue ink is more stable on your press than violet ink.
• Because blue ink may be less expensive than violet ink.

Choosing a Violet Ink

You may want to choose a violet ink (for example Pantone Violet C) for three reasons:
• To get maximum gamut expansion: as you can see below, adding a blue ink (on the left) provides less gamut expansion than adding a violet ink (on the right).

• If violet ink is more stable on your press than blue ink.
• If you print jobs that have lots of violet hues: you can reproduce a blue quite accurately by mixing violet and cyan inks, but you can’t reproduce a violet with the same accuracy from a blue and a magenta ink.

3.3 Choosing your Printing Target

A common method of performing quality control on your press output is by using a dot gain target (deciding what dot gain you want your printed output to have, and making the press match it).

This may be required if you are working with a pre-media house or a large brand owner (for example they may need you to print G7 compliant or ISO certified), or you may have your own quality target or follow another standard (for example if you are printing on less usual substrates).
The Equinox Profile Creator can help you get from the initial dot gain on your press to your desired dot gain target. This is achieved by synchronizing the Equinox profile you are making for your press to your desired target.

### 3.3.1 Printing to G7

The Equinox Profile Creator provides out-of-the-box support for G7.

G7 is a specification from IDEAlliance’s GRACoL committee, aimed at matching color on printing devices, with an emphasis on gray balance.

For expanded gamut printing, printing to G7 means that:

- your CMYK inks should have the dot gain specified by G7,
- your expanded gamut inks should have linear dot gain.

### 3.3.2 Printing to ISO, another Standard or a Custom Target

With the Equinox Profile Creator, you can also use curve sets you created in Curve Pilot to define the standard you want to print to. This can be for example:

- the ISO standard,
- another standard applicable to your specific type of printing (for example if you are printing on less usual substrates),
- your own target dot gain curves.

A curve set contains a target for each ink of your ink set (among other information).

For more information about curve sets, please see the Curve Pilot PressSync documentation.
4. Preparing for Measuring in the Equinox Profile Creator

Before measuring charts and/or creating an Equinox profile, we recommend you set a few preferences to adapt the Equinox Profile Creator to your environment and way of working.

Click **Edit > Preferences...**

4.1 Preferences for Both License-Free and Licensed Mode

For both measuring charts and creating an Equinox profile, you should set some preferences for visualizing, printing and measuring colors.

1. In the **General** tab, click **Monitor** and choose a **Monitor Profile** to display colors more accurately on your monitor.
   
   This is used for displaying inks and charts, and for example when comparing color patches visually.

   **Attention:** You should never judge color accuracy on a monitor only as this will not reflect your final output!

2. Click **Test Charts** and select the **Font** and **Units** to use when creating test chart files to print on your press.

3. In case you experience problems with the application and need support help, enable the **Logging** options:
   
   a) Select **Enable Log Window** to show logging information in a log window, that you can open from **Window > Log Window**.
   
   b) Select **Enable Extra Logging** to show more extensive logging information.

   **Attention:** Only select this when you need to troubleshoot the application as it may affect performance.

   **Note:** These options come into effect the next time you start the application.

4. If you want to always have the Equinox Profile Creator full screen, click **Start Up** and select **Always maximize the application window on start up**.

5. Go to the **Spectrophotometer** tab and select your **Preferred Spectrophotometer**.

   The Equinox Profile Creator supports the **X-Rite i1Pro** and the **X-Rite i1iO** spectrophotometers.

   The application detects the connected spectrophotometer automatically, but if you always use the same spectrophotometer, you can select it here to speed up the automatic detection.
Equinox Profile Creator

Note:
Only select **Use dummy spectro** if you want to demonstrate how to use the Equinox Profile Creator with a spectrophotometer (for example to a customer or colleague) but don’t have one connected. This option simulates measuring with an X-Rite i1iO spectrophotometer.

To perform real measurements, deselect **Use dummy spectro** and connect a real spectrophotometer to your application!

6. Select the **Preferred Measurement Condition** to use with your spectrophotometer.

Measurement conditions have been introduced by the printing industry to correct measurement variations caused by optical brightening agents in newer substrates.

Measuring a substrate containing optical brightening agents with a light source containing ultraviolet radiation causes fluorescence, making the substrate appear “whiter than white”. The more UV is in the light source, the higher the fluorescence, and the whiter the substrate appears.

Different measurement conditions correspond to different amounts of UV, and will give different Lab values for the white point.

⚠️ **Attention:** When measuring your substrate several times, always use the same measurement condition.

- **M0** represents an incandescent lamp close to CIE’s (Commission Internationale de l’Eclairage) "Standard Illuminant A", with a color temperature of about 2856 K.

  This is the measurement condition used by most of the world’s spectrophotometers and densitometers (for example older X-Rite and former GretagMacbeth instruments).

  As M0 does not define how much UV is in the light source, it is not recommended to use it to measure substrates with optical brightening agents (causing fluorescence), especially if you need to exchange measurement data between facilities (that may use different types of spectrophotometers).

- **M1** represents a light source matching CIE’s "Illuminant D50", but with a controlled amount of UV radiation, and compensating for the fluorescence caused by that radiation. Note that this compensation is only valid for measuring optically brightened papers, but not for measuring fluorescent inks or toners.

- **M2** represents a light source that excludes UV radiation (like a UV filter), so that substrates with optical brightening agents can be measured without fluorescence under this measurement condition.

- **M3** excludes UV radiation too, but also contains a polarization filter, which reduces the measurement differences between wet and dry samples, by minimizing the extra reflection from the "glossy" surface of the wet ink.
Note:
If the **Preferred Measurement Condition** you set here is not supported by your spectrophotometer, the Equinox Profile Creator will use a measurement condition supported by your spectrophotometer instead.

For example, the X-Rite i1iO and older versions of the X-Rite i1 only support M0. If you set M1 as your **Preferred Measurement Condition** but measure with an i1iO, the Equinox Profile Creator will use M0 instead.

Tip:
When you have a spectrophotometer connected, you will see its name and the measurement condition it uses at the bottom right of the application window.

You can right-click the green dot next to the spectrophotometer name to **Reconnect** or **Calibrate** it, or change its **Measurement Condition**.

### 4.2 Preferences Specific to the Licensed Mode

If you have an Equinox Profile Creator license and want to **create an Equinox profile** for your press, we recommend you also set the following preferences:

1. In the **General** tab, click **Default Formulas** and choose the **Default Delta E Formula** used to calculate the accuracy of color matches. You can select one of the following:
   - CIELab Delta E (classic)
   - Delta E 94
   - Delta E 2000
   - CMC (1:1)
   - CMC (2:1)

   **Note:** If your company is already using one of those standards, we recommend that you choose the same one. If not, you should choose the most recent one, Delta E 2000.

2. If you are using a densitometer, select the density standard set on it in **Default Density Formula**.

3. If you are planning to create an Equinox profile, you should make sure that you are using the Equinox Profile Creator in licensed mode.

   To do this, click **Start Up** and make sure **Give warning when application starts up in license free mode** is selected.

   This way, if for some reason your license is not available, you will see a warning on top of the splash screen with the message **No license was found. The application will start up in license free mode with reduced functionality.** when starting up the application.
In this case, please ask your administrator to double-check whether you have a license and whether it is present in your Esko Network or Local License Manager. For more information please consult the Network License Manager or Local License Manager documentation.

4. If you are working with an Esko server (for example an Automation Engine server or a Digital Front End server), you can connect your Equinox Profile Creator to that server. This way, you can use the same color and curves databases for your Esko server and your Equinox Profile Creator, which means that:

- When you create an Equinox profile, it will be automatically saved in a place where it is also accessible by other Esko applications.
  So for example, this profile will be available in Automation Engine’s color and proofing related tasks without you having to do anything extra.
- You can use a curve set you created in Curve Pilot as a dot gain target for your profile.
  a) Click Servers.
  b) In Server Name, enter the name of your Esko server.
  c) Enter your User Name and Password.
  d) Click the Check Connection button.
  If the connection is successful, you will see a green dot with the text Connected.

5. Select where your color management database is located. Click Database and choose either:

- **Obtain from Esko server** if you are working with an Esko server and your color database is located on that server, or if the color database location is defined on that server.
  
  **Note:** You need to be connected to the Esko server. You can click the Select link to go to the Servers tab and connect to the Esko server.

- **On remote computer** if your color database is located on a computer in your network. Fill in the name or IP address of that computer.

- **On local computer** if your color database is located on the computer running your Equinox Profile Creator application.
  
  **Note:** If you have been using the application in license-free mode previously and have created custom charts, those will automatically be added to the database you select now.

You will see the location of the color database you defined in Path Details. This also shows where the Equinox Profile Creator will look for the curves database (generally next to the color database).

**Attention:** You must restart your Equinox Profile Creator application after changing the color database location.
5. Using the Equinox Profile Creator in Licensed Mode

What is the Licensed Mode?
In licensed mode, you can *create custom charts* and *measure your printed charts* like in *license-free mode*, but you can also *create Equinox profiles*.

**Attention:**
You can only create an Equinox profile for your press if your Equinox Profile Creator is in licensed mode.

You can see whether the application is licensed when opening it. In license-free mode, you will see:

- a warning on top of the splash screen with the message **No license was found.** The application will start up in license free mode with reduced functionality. (unless you chose to hide this warning when using the Equinox Profile Creator previously),
- the text **No license available** on the splash screen itself (you can also open the splash screen from Help > About... at any time).

In this case, please ask your administrator to double-check whether you have a license and whether it is present in your Esko Network or Local License Manager. For more information please consult the Network License Manager or Local License Manager documentation.

If you previously used your copy of the Equinox Profile Creator in license-free mode, you will need to *select the location of your color database* the first time you use it with a license.

Working with Profiles
After starting the Equinox Profile Creator in licensed mode, you see the **Profiles Library**, listing all the profiles in your color database. It can contain:

- **Equinox profiles** if you have already created some.
  
  Equinox profiles that you have started working on but not completed have an orange spanner 🧰. You need to complete these profiles before you can use them on your press.

- **Esko profiles**, that are created when measuring a profile in Color Engine Pilot.
  
  They can be **Monitor Profiles** to view inks on screen, **Output Profiles** for digital presses and proofers, and **Press Profiles** for conventional presses.

- **ICC profiles**, that are written in a standard format that is OS independent.
  
  They can be **Monitor** or **Output** profiles.

All profile types can be CMYK or multicolor profiles (for example CMYKOG).

For each profile, you can see whether the profile is read-only ☑️ (for certain predefined profiles), the profile’s **Ink Set**, and any **Keywords** attached to the profile.
Tip:
You can use keywords to group profiles or overprint charts logically, and to easily find them again (by sorting on the Keywords column or using the Search field).

To assign a keyword to an existing profile or overprint chart, select that profile or chart then click in the Keywords column and type in your keyword. To enter several keywords, separate them by a comma.

You can also add keywords when creating a profile.

You can double-click a profile to open it and see Profile Information:

• a gamut plane, showing the colors contained in the profile's color space (the colors that the device can reproduce), for a certain lightness or a certain hue. You can change the lightness or hue to view a different "slice" of the profile's color space.

• some more details about the profile at right (when it was created, its data type, the spectrophotometer used...).
• which inks, from which ink books, where used to make the profile.

You can also view the Measurements used to make the profile, and if necessary you can measure some patches again or repair them.

If you open an Equinox profile, you can also view some information about its profile sections.

5.1 Creating an Equinox Profile for your Press

Once you have...

• made sure your press is stable
• chosen the inks to use
• chosen the curves you want to match

... you can start profiling your press for expanded gamut printing with the Equinox Profile Creator.
1. Click **New Equinox Profile** to start creating an Equinox profile.

2. Enter a **Profile Name** for your Equinox profile.
   
   As you are typing, you can see underneath a list of profiles starting with the same name that already exist in the Profiles library. This helps you make sure that the name you are entering hasn’t been used before, and that it conforms to any naming conventions you may use.

3. Define the **Ink Set** you have **selected** for expanded gamut printing on your press.
   
   See *Defining your Ink Set* on page 22.

4. Set what you want to use as your quality target (calibration curves derived from a standard or custom calibration curves).
   
   See *Setting your Desired Curves* on page 23.

5. If desired, you can add one or more keywords to your Equinox profile: select **Add keywords** and enter your **Keywords** (separated by a comma).

6. Click **OK** to go to the **Sections** view of your Equinox profile, which shows a list of your profile’s sections, based on the ink set you chose.

   A **section** is a part of the profile that describes how some of the inks print together. For example a CMYKOGV profile has the following sections:

   - CMYK,
   - OMYK (also called “the Orange section”),
   - CGYK (also called “the Green section”),
   - CMVK (also called “the Violet section”).

7. **Print and measure** a profiling chart for each of the profile sections, to have information about how the press prints with the inks in that section.

   You can either:

   - measure your charts in the Equinox Profile Creator,
   - import measurement files if you have measured your charts elsewhere.

   See *Printing and Measuring your Charts* on page 23.

8. **Process** each profile section to improve its quality, and help you get better and more consistent results with expanded gamut printing. This consists of:

   - **Inspecting** the measurement data and repairing faulty patches.
   - **Averaging** several measurements of a chart to correct for variations across a sheet or across press runs.
   - **Smoothing** your profile data to further compensate for press variation.
   - **Synchronizing** your profile to your chosen **standard or custom target** so that the profile’s dot gain matches the dot gain expected by the standard/target.

   See *Processing your Profile Sections* on page 31.
9. If desired, you can derive compensation curves from your profile data to help you meet your desired target on your production runs. See *Updating your RIP Curves with your Profile Data* on page 42.

5.1.1 Defining your Ink Set

1. Select the **Ink Set** to use for your Equinox profile (this is the ink set you have selected for expanded gamut printing on your press).

   It can consist of 5 to 7 inks: (CMYK plus any combination of Orange/Red, Green and Violet/Blue). Orange/Red, Green and Violet/Blue are **expanded gamut inks** and are often indicated using their abbreviations (O/R, G and V/B).

   The illustration at the left of the dialog shows the ink set you have chosen visually. For example:

   ![CMYKOGV](image1.png) ![CMYKRB](image2.png)

   **Tip:** You can also use the Equinox Profile Creator to make your CMYK profiles, as it is easier to ensure a high profile quality (by averaging, smoothing and synchronizing your measured data) in the Equinox Profile Creator wizard.

2. By default, every ink set uses CMYK inks from the **process** ink book, and expanded gamut inks from the **ClassicColors** ink book.

   However, you can replace any of these inks by an ink of your choice, as long as it still matches the ink set you selected.

   For example, you can replace a blue ink by another blue ink, but not by a red/violet/... ink.

   To do this:
   a) Right-click the ink to replace and select **Replace Ink...**
   b) In the dialog that opens, browse to the ink of your choice (or **Search** for it in your chosen ink book) and click **Select**.

   **Tip:**
   You can also click on a selected ink and type the name of the ink to replace it with. Or type part of the ink name and press **Enter** to auto-complete it.

   For example to replace **Red** by **PANTONE Warm Red C**, type **warm** and press **Enter**.

   If the ink you selected doesn't match the original ink set, you will get a warning.
In this case, you can either select an ink that does match the ink set, or change the ink set and then replace the ink.

5.1.2 Setting your Desired Curves

If you have chosen a printing target for your press, you should indicate it when starting to make your Equinox profile, so you can later synchronize your profile to that target.

- If you don’t have a printing target you want to match when working with Equinox, select Don’t synchronize the profile.
- If you want to print to G7, select Synchronize using standard G7 settings.

Note:
In this case:
- the target dot gain for your CMYK inks is the dot gain specified by G7,
- the target dot gain for your expanded gamut inks is linear.

- If you want to print to another target (ISO, another standard or a target of your own), select Use desired curves from Setup in Curve Pilot Curve Set and choose the curve set containing the dot gain targets for your inks.

Note:
If you cannot select this option, check that:
- You have created and saved your curve set in Curve Pilot (see the Curve Pilot PressSync documentation for more information).
- Your curves database (containing the curve set) is in the location defined in the Preferences.

If your curve set doesn’t have a target defined for some of your inks, the target defined for “Other inks” in the curve set is used for those.

You can then see the Desired Curve for each profile ink in the table above.

5.1.3 Printing and Measuring your Charts

After defining your ink set and setting your desired curves, you can print and measure profiling charts to add the expanded gamut printing measurement data to your profile.

Important: Print your charts using some good initial dot gain curves in the RIP (see Before You Start on page 7).

You can either:
- Measure your charts in licensed mode, while making an Equinox profile for your press.
  See Measuring Charts for your Profile Sections on page 25.
- Measure your charts in license-free mode, and export the measurements.
See *Measuring your Printed Charts* on page 50.

You can then import these measurements into a licensed Equinox Profile Creator to make an Equinox profile for your press.

See *Importing Chart Measurements* on page 28.

**Tip:**

You may want to work like this if for example you are working at an auxiliary site, but your company’s color expert (who will make the expanded gamut printing profile for your press) is at the company’s main site (and has a licensed Equinox Profile Creator there).

See *Licensed and License-free Modes* on page 6 for more information about which features are included in which mode.

In any case, make sure you measure your charts with one of the supported spectrophotometers.

**What Type of Chart Should I Use?**

You can either use standard charts or make custom ones (for example you can create narrow charts to profile a narrow web press).

We recommend you use randomized charts (for example the IT8.7/4 i1iO chart or a randomized custom chart) as those alleviate some of the printing variations in your press.

For example if you have "color jumps" near the line endings, a regular chart like the one below can concentrate all of the color jump in one area of the profile,

![Regular Chart Example]

while a randomized chart like the one below will distribute the color jump in more of the profile, which is easier to compensate using *averaging* and *smoothing*. 

![Randomized Chart Example]
How Many of Each Chart Should I Print?

You should ask your press operator how your press drifts, in which situations it behaves differently, and ideally get charts printed in each of these situations.

For example you might want to print charts:

- first thing in the morning
- at the end of the day
- right after stabilizing your press (for example if you use a control strip for quality control)
- right before the next time you stabilize your press
- ...

... to have a good picture of the press behavior (if you print all the profiling charts just after stabilizing your press, the profile will only be representative of the first half day of the press operation!).

In each of these cases, we recommend that you include several charts on the plate, to account for left/right and sheet start/sheet end printing differences (you can also rotate some of the charts if necessary).

Your operator should then let the press pick up speed, and take a number of samples from the start, the middle and the end of the press run, before letting the press slow down again.

Also remember that the less stable your press is, the more measurements you need to make a profile that is representative of the way your press prints.

Measuring Charts for your Profile Sections

If you are creating an Equinox profile, and measuring profiling charts to add measurement data to your profile’s sections, do the following for each section:

1. Select the section for which you want to measure a chart and click **Measure Chart...** under **Step 1** at right.

   This opens the **Measure Data for Section** wizard, that will guide you through measuring your chart.
2. Select the Overprint Chart you want to measure (see What Type of Chart Should I Use? on page 24 for more information).

**Tip:** You can create a custom chart from here by selecting **New Overprint Chart...**

You can see a Preview of the chart you selected, and some information about the chart (number of pages, dimensions, data type...) on the right.

You can also view a higher resolution of the chart (click **View Chart**) and the chart’s location on your computer (click **Show File Info**).

**Tip:**

You can save the Chart as PDF..., which can be useful if:

- you haven’t printed your chart yet (for example if you didn’t have the right chart file).
- another site at your company wants a press profiled and they don’t have a licensed Equinox Profile Creator (in this case, you should save each section’s chart as PDF, and send those PDFs to that site for printing on their press; they can then measure them using the application’s license-free mode).

3. Follow the instructions on the Measure page ... screen to measure your chart.

**Note:** If necessary, you can pause a measurement, or use the action button [ ] to stop, reconnect or calibrate the spectrophotometer. You can also choose a different measurement condition.

**Note:**

- If the spectrophotometer cannot detect any patches, or ends up partially or completely over a gap instead of over a patch, you should stop it, place it correctly and restart it.

The spectrophotometer cannot detect this automatically, so you should check whether the patches you see on screen correspond to those on the printed chart.

- By default, the spectrophotometer reads the chart line by line (in "scan mode"). If it cannot read a line on the chart, after 3 tries it will switch to measuring patch by patch ("patch mode"), until the end of the line (the application then shows a red rectangle around the patch being measured). This is slower but more fail-safe.

For the next line, the spectrophotometer automatically switches back to scan mode.

If you notice that the chart is of very bad quality (for example if the patches have bled, covering the gaps), and you cannot get a chart of better quality, you may want to measure the whole chart in patch mode from the start (instead of trying to measure each line 3 times in scan mode, then switching to patch mode).

4. After you finished measuring, you can check your measurements:

- as they are organised in the profile in **Profile** view,
5. To inspect a single patch more in detail, select it to show its ink composition and its Lab/LCH values.

6. To remeasure a patch that is an obvious measurement error (for example a black or white patch in the middle of a gradation), you can either:
   - select it and click **Measure Again**...
   - right-click it and select **Measure Again**...
Note: If you have a lot of measurement errors, we recommend you go Back and remeasure the problematic page(s) completely.

7. If you cannot remeasure the patch (for example if it is damaged on the chart), you can repair it by:
   • selecting it and clicking Repair Selected Patch,
   • selecting it and pressing Ctrl+R,
   • right-clicking it and selecting Repair Selected Patch.

Repairing a patch discards its bad color values and replaces them by a good approximation of what the color values should be, based on those of the neighboring patches.

Note:
Patches that look "wrong" but don’t change when you remeasure them and aren’t damaged on the chart are likely to be a variation or quirk in the way the press prints (especially if you find several of them in the same area of the chart).

You should not repair those patches but leave them as they are, as they are representative of how your press prints.

8. When you are done, enter a name for your measurements and click Finish.

You can also save your measurements as a CGATS (Committee for Graphic Arts Technologies Standards color measurement format) file for backup purposes.

9. In the Sections view, you can see some information about your measurements (the name, number of patches and whether they are Spectral or Lab measurements).

You can also see a preview of the measurements and more details below (including the measurement condition used if one was set on your spectrophotometer).

10. Click Show larger preview and/or compare measurements... to inspect the measurements from your file and, if you have several measurements, to compare them to each other.

Importing Chart Measurements

If you have measured your profiling charts elsewhere, and you have measurements files, you can use those to create your Equinox profile.

For example, you can use measurements files from:
   • a license-free Equinox Profile Creator,
   • the Color Engine Pilot,
   • a third party application like Profile Maker.
Note:
Your measurements files must be in the **CGATS** format (Committee for Graphic Arts Technologies Standards color measurement format).

Depending on which application you used to measure your charts and export the measurement data, you may have:

- one CGATS file per **profile section** (if you used the Equinox Profile Creator or a third party application).
  
  See *Importing Single Section CGATS Files* on page 29.

- one CGATS file containing the overprints measurements for the whole profile (if you used the Color Engine Pilot).
  
  See *Importing Multi-Section CGATS Files* on page 30.

**Importing Single Section CGATS Files**

If you have measured a profiling chart per section (for example a CMYK, OMYK, CGYK and CMVK chart to make a CMYKOGV profile), you can export each chart's measurements as a CGATS file.

You can do this for example in a license-free Equinox Profile Creator (see *Measuring your Printed Charts* on page 50) or in a third party application (see your application's documentation).

You can then import these CGATS files into your Equinox Profile Creator profile:

1. Select the section for which you want to import measurements and click **Import Measurements...** under **Step 1** at right.

2. Browse to your CGATS measurements file (it should have a `.txt` or `.it8` extension) and click **Open**.

   You can import several measurements files at once. Using **several measurements** allows you to **average** your measurements later, and helps the profile being more representative of how your press prints.

   **Note:** Make sure you are selecting the correct measurements file for the section you are working on. If you select a measurements file for another section, the application will give you the option to import it for that other section instead.

3. You can see some information about the measurements you have added (the measurements file's name, number of patches and whether it contains **Spectral** or **Lab** measurements).

   You can also see a preview of the measurements and more details below (including the **measurement condition** used if one was set on your spectrophotometer).

   **Note:** When using several measurements, we recommend they all have the same:
   - number of patches,
   - data type (**Spectral** or **Lab**),
   - measurement condition.

4. Click **Show larger preview and/or compare measurements...** to **inspect** the measurements from your file and, if you have several measurements, to **compare** them to each other.
Importing Multi-Section CGATS Files

If you have an existing Equinox profile in the Color Engine Pilot and you want to:

• take advantage of the Equinox Profile Creator to _improve your profile’s quality_,

• update your profile by adding new measurements (and _average them_ with the old ones) to get a more comprehensive picture of how your press prints,

... you can export your existing profile’s data to a multi-section CGATS file, and import that file into your new Equinox Profile Creator profile.

**Tip:**
To export an Equinox profile’s data to a multi-section CGATS file in the Color Engine Pilot:

1. Open the (Esko or ICC) profile and go to _File > Export_.
2. Save the file as a _CGATS data file (.txt)_.

To import the CGATS file into your Equinox Profile Creator profile:

1. Select any profile section and click _Import Measurements..._ under _Step 1_ at right.
2. Browse to your CGATS measurements file (it should have a .txt or .it8 extension) and click _Open_.

   The Equinox Profile Creator will then split the measurement data it finds in the file to assign it to the different sections.

3. In the _Choose Section_ pop-up, check that the right measurement data is imported into the right section (for example, the measurement data of the OMYK overprints will be imported into the _Orange_ section).

   If your CGATS file has measurements for the same inks as the ones you picked for your profile, this should all be correct automatically.

   If it has measurements for different inks, you will see a warning sign ⚠. You can then choose to:
   
   • discard the irrelevant data (if for example, the file has Green overprint data but the profile needs Violet data) by selecting _<Do Not Import>_,

   • import the data in question anyway (if for example, if you are using a blueish Violet ink for your CMYKOV profile and the application identifies it as a Blue ink).

4. You can see some information about the measurements you have added (the measurements file’s name, number of patches and whether it contains _Spectral_ or _Lab_ measurements).

   **Note:** You can _Remove_ a multi-section CGATS file from a certain section without removing it from the other sections.

You can also see a preview of the measurements and more details below (including the _measurement condition_ used if one was set on your spectrophotometer).
5. Click **Show larger preview and/or compare measurements**... to inspect the measurements from your file and, if you have several measurements, to compare them to each other.

### 5.1.4 Processing your Profile Sections

Once you have measured a profile section or imported a measurement file for it, you can process that section to improve the quality of your profile data.

By processing your profile, you can correct or compensate for the "noise" in the profile data, and make the profile match your desired standard.

1. Once you have your measurements for a section, that section has the **Ready to Process** status in the top table.

**Note:**

You can process any profile section for which you have measurements, but if you are printing towards G7, you should process your CMYK section first.

This is because:

- first the CMYK section is synchronized to your standard (so for example the Cyan prints with the Cyan dot gain defined in the standard),
- then the C, M, Y and K inks in the other sections (for example OMYK, CGYK, CMVK) are synchronized to the processed CMYK section, to keep the profile consistent and avoid the risk of having color jumps in your jobs.

Both in the **Sections** view and when processing, you can see the profile section you are currently working with highlighted on the color wheel, for example:

![Color Wheel Diagram]

2. Make sure the section you want to process is selected and click **Process Section**... under **Step 2** at right.

This opens the **Processing Section** wizard, that will guide you through the following steps.
If necessary, you can pause the processing at any time and finish it later:

1. Click *Quit Now and Continue Later* and confirm by clicking *Save and quit* in the pop-up dialog.
   
   This closes the processing wizard and shows a 📚 badge next to the section you were working with in the Sections view.

2. When you are ready to resume processing, select your section again and click *Process Section*…

   In the pop-up warning you about the unfinished processing work, click either:

   • **Resume** to go to the point where you paused processing in the wizard and continue from there.
   
   • **Discard and Restart** to discard your previous processing work and start anew.

3. First you need to inspect your measurements, and repair any patch that looks like an obvious measurement error.

   See *Inspecting and Repairing your Measurement Data* on page 32.

   **Note:** If you have several sets of measurements for a section, the inspection step is part of the averaging step.

4. If you have measured *several printouts* of your chart, you can average those measurements to correct for variations across the sheet or across the press run.

   See *Averaging your Measurement Data* on page 34.

5. You can then smooth your measurements, to further compensate for press variation.

   See *Smoothing your Measurement Data* on page 37.

6. If you are printing towards a *standard or custom target*, you can now apply compensation on your profile data so that it matches that standard or target.

   See *Synchronizing your Measurement Data to your Desired Curves* on page 40.

   **Note:** If you have chosen not to match any standard or target, the synchronization step will be skipped automatically.

7. If necessary, you can discard the processed data for a section and re-process it: just select it and click *Process Section*… again.

For example, if you have added or removed measurements after processing the section, you need to reprocess it.

**Inspecting and Repairing your Measurement Data**

You should first have a good look at the profile data you measured, and repair any outlier (any patch that is so different from its neighbors that it is most likely to be a measurement error) if necessary.
• If you only measured one chart for the profile section you are working on, you can do this in a separate step (Inspect Data Set) when starting the processing wizard.

• If you measured several charts for that section, you can do this at the start of the averaging step.

Note: You can (and should) also inspect your data in the smoothing and synchronizing steps, to make sure you are happy with the results.

1. Inspect the profile data you measured.
   
   You can see the measurements:
   
   • as they are organised in the profile in Section view,
   
   • as they have been measured on the chart in Layout view.
You can zoom in, zoom out, or fit the zoom to the view.

2. You can Highlight the Substrate patch, the Primaries or the Greys if you want to perform a visual check on those parts of your measurements.

3. To inspect a single patch more in detail, select it to show its ink composition and its Lab/LCH values in the Patch Details at right.

4. To repair a patch that is an obvious measurement error (for example a black or white patch in the middle of a gradation), you can either:
   - select the patch and click the Repair Selected Patch button,
   - select the patch and press Ctrl+R,
   - right-click the patch and select Repair Selected Patch.

**Note:**
Repairing a patch discards its bad color values and replaces them by a good approximation of what the color values should be, based on those of the neighboring patches.

We recommend you only repair patches that look like obvious measurement errors, and not patches that look more variations or quirks in the way the press prints, as those can be corrected by averaging and smoothing, which don’t completely discard the original data but give a better version of it.

A good rule of thumb is that isolated color jumps can be measurement errors, but if you find several of them in the same area of the chart, it’s likely to just be how the press prints.

**Attention:** If you have a lot of measurement errors, we recommend you remeasure the chart completely!

**Averaging your Measurement Data**

If you printed and measured your profiling chart for the section several times as recommended (with the chart placed several times on the plate, and ideally in several press runs), you can average your chart measurements.

**What is Averaging?**

If you only print and measure one chart, it is printed under specific conditions (for example, near the left edge of the paper, or first thing in the morning) which are most likely not representative of how all the jobs you send to this press are printed.
By averaging several measurements, you make sure that your profile is a good representation of your press behavior in general.

Averaging in the Processing Wizard

The wizard’s **Create an Averaged Data Set** step shows all of the measurements you added, and what the profile section looks like after averaging those measurements.

We recommend that you:

1. First *inspect* the averaged profile section.
   
   It should look relatively smooth in **Section** view. If you see strong color jumps here, it is generally because one or more of your chart measurements is of bad quality.

2. Then look at each chart measurement individually: select each one in **Show** and inspect it.
   
   If any of the chart measurements is really jumbled or has a very high amount of noise, you should determine whether this is usual for your press or not.
   
   If it is an isolated problem, you should not use that chart measurement to make the averaged section: deselect it in the **Use** column.
   
   The average is updated automatically.

3. If you see individual patches that are obvious measurement errors (for example single black or white patches in the middle of a gradation), *repair* them.

4. To detect less obvious problems more easily, compare each chart measurement to the averaged section:
   
   a) With your chart measurement selected in **Show**, select **Compare with** and choose **Average** to show the split patch view.
   
   b) In the **Statistics** at right, have a look at the Delta E values to see where the differences are.
      
      - If your **Average** Delta E is high, it may be that one of your charts is wrong (for example you accidentally measured a chart printed by a different press) or you may need to look at the rest of the statistics for more investigation.
      
      - If your **Maximum** Delta E is very high, it’s likely that there are some measurement errors that you should repair.
      
      - If your **Primaries** Delta E is high, it could mean that something happened to your inks between printouts, for example:
• the inks got diluted, or the pressure on the plates changed (in flexo printing),
• the ink-water balance changed between prints (in offset printing),
• you printed one of the charts with different inks, or with a different screening.

• A high Grey Delta E may mean that your grey balance shifted (pay special attention to this if you are printing towards G7).

• A high Substrate Delta E may mean that one of the charts was printed on a different substrate.

  c) You can also Highlight certain parts of your measurements to investigate problems visually.

  Apart from checking the Substrate, Primaries, Greys and Maximum Delta E, we recommend you pay attention to the Patches with above average Delta E and the Worst 10 percent, and look for patterns in the distribution of those patches.

• In Section view, you can see for example if most of the differences are clustered in one color area, which can point to a problem with one of your inks.

• In Layout view, you can check for patterns indicating a problem with one of the charts measured.

  In the example below, highlighting the Patches with above average Delta E in the comparison shows that one of the charts probably has two scratches or creases, that reflected the light differently when measuring.

  ![Image of a highlighted section showing scratches or creases on a chart]

  This is even clearer when highlighting the Worst 10 percent.
d) To get information about an individual patch, click it to show:

- the ink values that have been printed,
- the Lab/LCH values of this patch in both the single chart measurement and the average,
- the Delta E difference between the two.

in the **Patch Details** at right.

Based on the problems you find, you can discard other bad measurements and/or repair more patches as necessary.

---

**Attention:**

Do not discard too many chart measurements as this can lower the quality of your averaged section!

You need to keep enough measurements so that the average is representative of the way your press prints (we recommend you try and keep at least one chart from each *printing situation*).

Also remember that the less stable your press is, the more measurements you need to have a good average.

---

**Smoothing your Measurement Data**

Once you have *repaired* any bad patches and *averaged* your measurements for the profile section you are working on, you can smooth that section to further compensate for press variation.

Smoothing is especially important if:

- you are working with a press that can have a lot of variation or "noise" (for example a Flexo press),
- you couldn't average your measurements (because you could only measure one chart for that section),
- the measurements still look "coarse" after averaging (as below).
Smoothing makes sure that there is a more regular progression of the ink values between neighboring patches, so that you will have more reliable color tints on press, especially when printing jobs with gradations.

Smoothing in the Processing Wizard

1. In the Smooth Data step of the wizard, select a Smoothing Factor and click Apply Smoothing.

Note:
Keep the following in mind when choosing a Smoothing Factor:

- The higher the quality of your data after inspecting/averaging, the less smoothing you need to apply.
- In general, we recommend applying the lowest smoothing factor that gives a smooth result, to preserve your measurements' dot gain and color accuracy (in most cases, the default smoothing factor of 3 is sufficient).
- The wizard remembers the last smoothing factor you used and offers it as a default when smoothing again, so you can easily remember how much you smoothed the last section you processed, for example.

   However, you may want to use different smoothing factors for different profile sections. For example, a Violet section typically needs more smoothing than other sections.

Smoothing may take a few minutes, and is reversible (click Undo Smoothing) so you can try several smoothing factors on your profile section.

You can see the smoothing factor used above the measurements view.

2. After applying the smoothing, you can compare the smoothed and the unsmoothed profile sections.

   You can choose to have the wizard Show:
   - The profile section Before smoothing:
• The profile section After smoothing:

• A comparison of the profile section Before And After smoothing (this shows a split patch view, with the unsmoothed data on top and the smoothed data at the bottom):
You can also inspect the profile section Before and After smoothing (to see the color differences in Delta E or the worst patches for example).

3. If necessary, you can still repair patches.

**Tip:** In many cases, it is better to apply a low smoothing factor and then repair the few patches you are not happy with manually, rather than smooth too much and risk losing some of the gradations and highlights information that is specific to your press.

**Note:**
- To repair a patch in the smoothed profile section, make sure you are in the After or Before And After view.
- If you repair a patch after smoothing but then you undo the smoothing, your repair will also be undone.

*Synchronizing your Measurement Data to your Desired Curves*

After repairing, averaging and smoothing your measurement data to make sure it is the best quality possible, you can now synchronize it to the target you have chosen.

**What is Synchronization?**
Synchronizing the profile to a target means applying a compensation on the profile data, so that when printing with this profile, the dot gain on press will match the dot gain specified in the target.

**What about the RIP Curves?**
You also need to update your RIP curves to take into account the way your press prints, as described by your profile.

You calculate your updated RIP curves based on:
- the existing RIP curves,
• your profile data,
• the printing target you want to match.

This means that the profile and the RIP curves are adapted to help you match your printing target separately.

Using the Synchronized Profile and Updated RIP Curves in Production

Using your synchronized profile and your updated RIP curves should ensure that your output will, on average, match your target dot gain.

You may still need to tweak your RIP curves from time to time, if your press runs into specific problems (for example if some nozzles get clogged up), but you should keep using the synchronized profile to help match your target.

Synchronizing in the Processing Wizard

If you have set a printing target you want to match, you can synchronize your profile to that target in the wizard’s Synchronize step.

1. Click Apply Synchronization.

   Tip: Above the Apply Synchronization button, the wizard indicates which target you are synchronizing to.

   Synchronization may take a few minutes, and is reversible (click Undo Synchronization).

2. After applying the synchronization, you can compare the synchronized and the unsynchronized profile sections.

   You can choose to have the wizard Show:

   • The profile section Before synchronizing:

   • The profile section After synchronizing:
• A comparison of the profile section **Before And After** synchronizing (this shows a split patch view, with the unsynchronized data on top and the synchronized data at the bottom):

You can also *inspect* the profile section **Before** and **After** synchronizing (to see which areas of the profile have been changed the most by synchronizing for example).

3. **Click Finish** to finish processing your section.

   You can now process your profile’s remaining sections.

---

**5.1.5 Updating your RIP Curves with your Profile Data**

After creating a press profile *synchronized to your target*, you also need to update your RIP curves to take into account the way your press prints.
You do this based on:

- the existing RIP curves (that you used to print your profiling charts),
- your profile data (the data that describes your press behavior, before the profile is synchronized to your printing target),
- the printing target you want to match.

This means that the profile and the RIP curves are adapted to help you match your printing target separately.

1. Export your processed profile data as it was before synchronizing:
   a) In the Sections view, make sure you have processed all profile sections.
   b) Click Export Unsynchronized Data..., and save your profile data in your chosen location.

   The profile data is saved in the CGATS format.

2. Import that profile data into Curve Pilot, and calculate your new RIP curves based on the existing RIP curves, your profile data and the printing target you want to match.

   See the Curve Pilot documentation for more information.

5.2 Exchanging Profiles Between Sites

If you have several sites, we recommend you use the same color database.

However, if you are using several color databases, you can import and export your equinox profiles, either between two Equinox Profile Creator applications, or between an Equinox Profile Creator and a Color Engine Pilot.

For example:

- Your color expert or an Esko solution architect made an equinox profile for your press: they can export it from their Equinox Profile Creator and you can import it in yours.

  Note: This preserves all the data used to make the equinox profile (so if necessary, you can open and edit the imported profile as if you had made it in your own Equinox Profile Creator).

- You can export the profile you made in Equinox Profile Creator, then import it in Color Engine Pilot to make a color strategy using this profile (see the Color Engine Pilot documentation for information about color strategies).

  Note: None of this is necessary if you are using a single color database, as every Equinox Profile Creator and Color Engine Pilot you have will have access to the same profiles.

5.2.1 Importing a Profile

You can import both Esko and ICC profiles. Esko profiles must have been exported as a FilePacker archive (with the extension .fp). ICC profiles can have the .icc or .icm extension.

1. Either:
   - choose File > Import...
   - press Ctrl+Alt+I

2. Browse to the profile to import and click Open.
You can select more than one profile using the Shift key, or select all profiles using Ctrl+A (if the location you browsed to only contains profiles).

**Tip:** If you have the location of the profile(s) to import already open, you can also:

- Drag the profile(s) onto the Equinox Profile Creator shortcut on the desktop.
- Drag the profile(s) into the Equinox Profile Creator application window.

### 3. In the Import dialog that opens, you can:

- Add or remove profiles to import using the + or - buttons.
- Check that all the profiles listed have the state 🔄 Ready for import.

**Note:**

Typically, most profiles will be Ready for import.

In some particular cases, profiles cannot be imported straightaway. For example, if you are trying to import a (non equinox) profile made in a Color Engine Pilot application looking at a different color database. If that profile is made with specific custom inks that are not present in your color database, you will see ✗ Cannot import (missing inks) when trying to import it in your Equinox Profile Creator.

If you need to import such a profile, you should ask the person who made the profile to change the inks in their Color Engine Pilot and send it back to you (note that this will not be color accurate).

- See more information about a selected profile in the Details tab (you can see the profile’s Type - for example Press Profile - and the inks used as Profile Channels).
- Rename a profile if desired by clicking in the Import as column and entering a new name.

**Note:** If a profile with the same name already exists in the color database, the default name of the imported profile will be [profile name]_(2).

### 4. Import the profiles by either:

- selecting the profile(s) to import (using Shift to select several profiles) and clicking Import Selection at the bottom right,
- clicking Import All to import all profiles in the dialog.

You will see a progress bar, and import details in the Logging tab at the bottom of the dialog.

Once the profiles are imported, they will have the ✔️ Imported state. You can then Close the Import dialog.

#### 5.2.2 Exporting a Profile

You can export both Esko and ICC profiles.

1. In the Profiles library:

- select one or more profiles to export and choose File > Export... or press Ctrl+Alt+E.
- right-click the profile(s) to export and select Export...
Tip: Use the **Shift** key to select several profiles, or **Ctrl+A** to select all profiles.

2. If you selected...

- a single profile, browse to a location, enter an appropriate file name and click **Save**.
- several or all profiles, you will see the **Export** dialog.

1. Click **Browse** to select a location.
2. If desired, remove profiles from the export using the **Remove** button.
3. If desired, rename profiles by clicking in the **Export As** column and typing the new name (do this for example if you see a warning \⚠️\ that a file of the same name already exists in that location).
4. Click **Export**.

Esko profiles are exported as a FilePacker archive (with the extension .fp), while ICC profiles keep the .icc extension after export (you can also export them as .icm files).
6. Using the Equinox Profile Creator in License-free Mode

What is the License-free Mode?
The Equinox Profile Creator is also available in license-free mode, in which you can:

- *create profiling charts* for your press,
- *measure charts* that your press printed.

However, you cannot create an Equinox profile for your press in license-free mode.

*Tip:*
If you have several sites, you can for example have a fully licensed Equinox Profile Creator at the main site, and a license-free Equinox Profile Creator at your auxiliary sites.

When a press at an auxiliary site needs profiling, you can print and measure the profiling charts using the license-free Equinox Profile Creator, then export the measurement files and send them to your main site.

Your color expert at the main site can then create an Equinox profile in the fully licensed Equinox Profile Creator for that press.

Knowing Which Mode You are In
When opening the **Equinox Profile Creator** in license-free mode, you will see the following warning on top of the splash screen: *No license was found. The application will start up in license free mode with reduced functionality.*

If you don’t want the warning to pop up next time you use the application, you can select *Do not show this warning again* before clicking **Continue** (you can always reactivate it in the **Preferences** if desired).

You will still be able to tell that you are using the license-free mode when you see the text *No license available* on the splash screen itself. You can open the splash screen at any time from **Help > About...**

The Overprint Charts
After starting the **Equinox Profile Creator** in license-free mode, you see the **Overprint Charts Library**, listing all the charts in your color database (both predefined chart layouts, and chart layouts you have created).

You can see some general information about each chart (its name, number of pages, number of patches, dimensions...). You can also see which **Spectrophotometer** you can use to read the chart, and any **Keywords** attached to the chart.

*Tip:*
You can use keywords to group overprint charts logically, and to easily find them again (by sorting on the **Keywords** column or using the **Search** field).

To assign a keyword to an existing overprint chart, select that chart then click in the **Keywords** column and type in your keyword. To enter several keywords, separate them by a comma.
You can rename, duplicate or delete your custom charts, whereas predefined charts are read-only.

When selecting a chart, you can see a small preview of it at the bottom left of the application window (under Selected Item). You can see a bigger preview when measuring the chart.

### 6.1 Creating a Custom Chart

The Equinox Profile Creator offers a number of predefined overprint chart layouts, with different sizes and numbers of samples.

However, presses supports many different substrate formats, so if you are using a specific substrate that can't fit any of the predefined chart layouts, you can create your own layout (based on a predefined one).

In the Overprint Charts Library:

1. Click **New Overprint Chart** to start creating a custom overprint chart layout.
2. Enter the **Chart Name** you want to use.
   
   We recommend you use a brief but unique description of the layout as your chart name, to make it easy to choose between layouts when measuring your chart/creating a profile.

   The chart name will be displayed on the chart itself.

   **Tip:** As you are typing, you can see underneath a list of charts starting with the same name that already exist in the Overprint Charts library. This helps you make sure that the name you are entering hasn’t been used before, and that it conforms to any naming conventions you may use.

3. Select the **Spectrophotometer** you want to use for measuring your chart.
   
   By default, the spectrophotometer connected to your application is selected, but you can choose to use another supported spectrophotometer.

4. Choose which standard set of patches you want to use in **Patch Set**.
   
   For example, you would like to use an IT8/7.4 chart, but you don’t have the space for it on your substrate. In this case, you should choose the **IT8/7.4 Patch Set**, then adapt the **patch size** and **chart size**, so that your final layout does fit on your substrate.

**Note:**

The **Patch Set** you choose influences the quality of your future profile. Some patch sets contain more patches than others, ranging from several hundred to several thousand patches. Using more patches will result in more accurate colors.

However, if the press itself is unstable, printing more patches may not give better results, because press variation has a lot more impact on your printed result than how accurate your profile is. In this case, we recommend you take a smaller patch size and make more printouts.

In most cases, the **ECI2002** and **IT8/7.4** patch sets offer a good trade-off between the press space needed and the resulting profile quality.

You can see the number of patches present in the patch set you selected, and a preview of your chart at right.
5. Select Randomize to place the chart’s patches in a random order, so that asymmetries in printing (the press printing differently on different parts of the sheet) are more evenly distributed.

Profiles measured from randomized charts are generally more representative of how your press prints.

6. The Equinox Profile Creator will suggest a default Patch Width and Patch Height. However, when printing in lower quality (Flexo, low resolution...) you may want to increase the patch size to improve your results.

7. Define your Chart size, using either a number of rows and columns or a page size.

By default, the Equinox Profile Creator suggests the largest chart size that can be measured on the Spectrophotometer you chose. However, you may want to reduce the chart size to fit the chart on your press or proofer.

You can see how many pages and how many patches per page are in your chart at the bottom of the window. If you want your chart to have less pages, try reducing the size of the patches and/or increasing the chart size.

The preview at right reflects your layout changes. You can see how each page of your chart will look (when showing the Chart Preview) and how a profile measured from your chart would look like (when showing the Overprints).

8. When you are done, Save your chart to add it to the Overprint Charts Library.

Your chart is saved to a small local database.

Note: If you later get a license for the Equinox Profile Creator, all the overprints charts that you created in license-free mode will be imported automatically to the full color database that you will choose (so they will still be available in the Overprint Charts Library).

You can now Save your Chart as PDF, print it on your press and measure it.

Tip:
By default, the custom charts you create here are CMYK charts. If you want expanded gamut printing charts with the same layout (a chart per profile section), you can either:

- generate a PDF of your chart layout per profile section when measuring your charts,
- open the PDF of your CMYK chart in an editor application (for example ArtPro or PackEdge), and replace the inks to create your expanded gamut printing charts (for example replace Cyan by Orange for an OMYK chart, Magenta by Green for a CGYK chart, and Yellow by Violet for CMVK chart).

### 6.2 Exchanging Charts Between Sites

If your press operator (or an Esko solution architect) already created a custom chart layout that fits perfectly on your press, and you want to measure charts printed using that layout, do the following:

1. Ask your press operator/solution architect to export that chart layout using his/her copy of the Equinox Profile Creator (in either license-free or licensed mode).

   This will result in a FilePacker archive, with the extension .fp.

2. Import that archive into your own Equinox Profile Creator.
3. **Measure** the printed charts using that chart layout.

### 6.2.1 Exporting a Chart

1. In the **Overprint Charts** library:
   - select one or more chart layouts to export and choose **File > Export**... or press **Ctrl+Alt+E**.
   - right-click the chart layout(s) to export and select **Export**...

   **Tip:** Use the **Shift** key to select several chart layouts, or **Ctrl+A** to select all chart layouts.

   **Note:** You cannot export read-only layouts.

2. If you selected...
   - a single chart layout, browse to a location, enter an appropriate file name and click **Save**.
   - several or all chart layouts, you will see the **Export** dialog.

   1. Click **Browse** to select a location.
   2. If desired, remove chart layouts from the export using the **Remove** button.
   3. If desired, rename chart layouts by clicking in the **Export As** column and typing the new name (do this for example if you see a warning that a file of the same name already exists in that location).

   4. Click **Export**.

   The Equinox Profile Creator generates a FilePacker archive (with the extension `.fp`) containing your exported chart layout(s).

### 6.2.2 Importing a Chart

1. Either:
   - choose **File > Import**...
   - press **Ctrl+Alt+I**
   - right-click in the main pane (in the **Overprint Charts** library) and select **Import**...

2. Browse to the `.fp` file to import and click **Open**.

   You can select more than one packed chart layout using the **Shift** key, or select all chart layouts using **Ctrl+A** (if the location you browsed to only contains chart layouts).

   **Tip:** If you have the location of the `.fp` file(s) already open, you can also:
   - Drag the `.fp` file(s) onto the Equinox Profile Creator shortcut on the desktop.
   - Drag the `.fp` file(s) into the Equinox Profile Creator application window.

3. In the **Import** dialog that opens, you will see that the chart layouts have the state **Ready for import.**
In the **Details** tab at the bottom of the **Import** dialog, you can see a preview of the selected chart layout and some information about the layout (compatible spectrophotometer, ink set, number of patches, dimensions...).

**Tip:** You can add or remove chart layouts to import using the + or - buttons.

4. **If desired, you can rename the chart layouts by clicking in the **Import as** column and entering a new name.**

**Note:** If a chart layout with the same name already exists in the color database, the default name of the imported layout will be `[chart layout name]_(2)`.  

5. **Import the chart layouts by either:**

   - selecting the chart layout(s) to import (using **Shift** to select several chart layouts) and clicking **Import Selection** at the bottom right,
   - clicking **Import All** to import all chart layouts in the dialog.

You will see a progress bar, and import details in the **Logging** tab at the bottom of the dialog.

Once the chart layouts are imported, they will have the **✔ Imported** state. You can then **Close** the **Import** dialog.

### 6.3 Measuring your Printed Charts

To measure a chart your press printed:

1. **Select the chart you want to measure in the **Overprint Charts Library** and click **Measure Overprint Chart** (or double-click the chart).**

   This opens the **Measure Overprint Chart** wizard, that will guide you through measuring your chart.

2. **You can see the **Overprint Chart** you selected, a **Preview**, and some information about the chart (number of pages, dimensions, data type...).**

   a) **If this is not the chart you wanted, you can select the correct chart in the **Overprint Chart** list, or select **New Overprint Chart**... to **create a custom chart**.**

   b) **By default, the chart layout is shown in CMYK, but you can select another **Section** to measure if desired. The **Preview** then shows your chosen section.**

   c) **If desired, you can view a higher resolution of the chart (click **View Chart**) and the chart’s location on your computer (click **Show File Info**).**

   d) **If you haven’t printed your chart yet (for example if you didn’t have a chart file for the chart you want to print), you can **Save the Chart as PDF**... and use that PDF file to print the chart that you will measure.**
Tip:

If you only have your chosen chart in CMYK, but you want to print and measure this chart for different sections, you can do the following:

1. Select the first Section you want (for example Orange) then click Save the Chart as PDF...
2. Repeat this for all sections for which you need a chart.
3. Print these charts on your press.
4. Measure each of these charts with the Measure Overprint Chart wizard: for each chart, select the chart layout in Overprint Chart and the relevant Section, and then measure it as explained below.

Alternatively, if you are at an auxiliary site and your color expert at the main site has a licensed Equinox Profile Creator, you can ask him/her to save a chart per profile section so that you can print them on your press.

3. Follow the instructions on the Measure page ... screen to measure your chart.

Note: If necessary, you can pause a measurement, or use the action button to stop, reconnect or calibrate the spectrophotometer. You can also choose a different measurement condition.

Note:

- If the spectrophotometer cannot detect any patches, or ends up partially or completely over a gap instead of over a patch, you should stop it, place it correctly and restart it.

  The spectrophotometer cannot detect this automatically, so you should check whether the patches you see on screen correspond to those on the printed chart.

- By default, the spectrophotometer reads the chart line by line (in "scan mode"). If it cannot read a line on the chart, after 3 tries it will switch to measuring patch by patch ("patch mode"), until the end of the line (the application then shows a red rectangle around the patch being measured). This is slower but more fail-safe.

  For the next line, the spectrophotometer automatically switches back to scan mode.

  If you notice that the chart is of very bad quality (for example if the patches have bled, covering the gaps), and you cannot get a chart of better quality, you may want to measure the whole chart in patch mode from the start (instead of trying to measure each line 3 times in scan mode, then switching to patch mode).

4. After you finished measuring, you can check your measurements:

- as they are organised in the profile in Profile view,
• as they have been measured on the chart in **Layout** view.

You can view each page individually, and zoom in, zoom out, or fit the zoom to the view.

5. To inspect a single patch more in detail, select it to show its ink composition and its Lab/LCH values.

6. To remeasure a patch that is an obvious measurement error (for example a black or white patch in the middle of a gradation), you can either:

   • select it and click **Measure Again**...
   • right-click it and select **Measure Again**...
7. If you cannot remeasure the patch (for example if it is damaged on the chart), you can repair it by:
   - selecting it and clicking Repair Selected Patch,
   - selecting it and pressing Ctrl+R,
   - right-clicking it and selecting Repair Selected Patch.

   Repairing a patch discards its bad color values and replaces them by a good approximation of what the color values should be, based on those of the neighboring patches.

   **Note:**

   Patches that look "wrong" but don't change when you remeasure them and aren't damaged on the chart are likely to be a variation or quirk in the way the press prints (especially if you find several of them in the same area of the chart).

   You should not repair those patches but leave them as they are, as they are representative of how your press prints.

8. When you are done, click Save Measurements... to save your measurements as a CGATS (Committee for Graphic Arts Technologies Standards color measurement format) file.

   You will then be able to import this CGATS measurements file into a licensed Equinox Profile Creator to help create a profile for your press.
7. Using your Equinox Profile

7.1 Creating a Color Strategy for Use in Other Esko Applications

If you have Color Engine Pilot, you can make a color strategy that uses your Equinox profile as output profile.

You can then use this color strategy in Automation Engine, Imaging Engine, ArtPro, PackEdge... to have more flexibility and automation in your expanded gamut printing workflow.

Please see the documentation of these applications on http://help.esko.com for details about creating/using an Equinox color strategy.

7.2 Monitoring your Press Output

Your press will most probably drift over time, so you should monitor your output quality regularly, and correct any deviation.

**Note:** This is very important as press variation has even more of an impact on your printed results than profile quality!

You should pay particular attention to:

- dot gain (and fine-tune your curves as necessary),
- gray balance (especially if you are printing towards G7).

For example, you can include a control strip on your plates (either on every plate, or at regular intervals), or use a P2P chart.